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Chemical reactions occur to reach a state of equilibrium. The equilibrium state can be 
characterized by quantitatively defining its equilibrium constant, Keq. In this experiment, you will 
determine the value of Keq for the reaction between iron (III) ions and thiocyanate ions, SCN–. 

Fe3+ (aq) + SCN– (aq) → FeSCN2+ (aq) 
The equilibrium constant, Keq, is defined by the equation shown below. 

[FeSCN 2+ ] 
Keq = 

[Fe3+ ][SCN − ] 
 

To find the value of Keq, which depends only upon temperature, it is necessary to determine the 
molar concentration of each of the three species in solution at equilibrium. You will determine 
the concentration by measuring light that passes through a sample of the equilibrium mixtures. 
The amount of light absorbed by a colored solution is proportional to its concentration. The red 
FeSCN2+ solution absorbs blue light, thus the Colorimeter users will be instructed to use the 
470 nm (blue) LED. Spectrometer users will determine an appropriate wavelength based on the 
absorbance spectrum of the solution. 

 
In order to successfully evaluate this equilibrium system, it is necessary to conduct three separate 
tests. First, you will prepare a series of standard solutions of FeSCN2+ from solutions of varying 
concentrations of SCN– and constant concentrations of H+ and Fe3+ that are in stoichiometric 
excess. The excess of H+ ions will ensure that Fe3+ engages in no side reactions (to form FeOH2+, 
for example). The excess of Fe3+  ions will make the SCN–  ions the limiting reagent, thus all of 
the SCN– used will form FeSCN2+ ions. The FeSCN2+ complex forms slowly, taking at least one 
minute for the color to develop. It is best to take absorbance readings after a specific amount of 
time has elapsed, between two and four minutes after preparing the equilibrium mixture. Do not 
wait much longer than four minutes to take readings, however, because the mixture is light 
sensitive and the FeSCN2+ ions will slowly decompose. 

In Part II of the experiment, you will analyze a solution of unknown [SCN–] by using the same 
procedure that you followed in Part I. In this manner, you will determine the molar concentration 
of the SCN– solution using your calibration curve. 

 
Third, you will prepare a new series of solutions that have varied concentrations of the Fe3+ ions 
and the SCN– ions, with a constant concentration of H+ ions. You will use the results of this test 
to accurately evaluate the equilibrium concentrations of each species. 

 

OBJECTIVES 
In this experiment, you will 

• Prepare and test standard solutions of FeSCN2+ in equilibrium. 
• Test solutions of SCN–  of unknown molar concentration. 
• Determine the molar concentrations of the ions present in an equilibrium system. 
• Determine the value of the equilibrium constant, Keq, for the reaction. 
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MATERIALS 
 

Check out from Stockroom 
Vernier LabQuest 
LabQuest App 

In the classroom 
0.200 M iron (III) nitrate, Fe(NO3)3, solution 
in 1.0 M HNO3 

Vernier Colorimeter or Spectrometer 
plastic cuvette 

0.0020 M iron (III) nitrate, Fe(NO3)3, solution 
in 1.0 M HNO3 

pipet pump or bulb 
50 mL volumetric flask 

potassium thiocyanate, KSCN solution of 
unknown concentration 

 0.0020 M thiocyanate, SCN– 
 plastic Beral pipets 
 tissue 
 six 20 × 150 mm test tubes & test tube rack 
 eight 100 mL beakers 

 

PROCEDURE 
Part I:  Prepare and Test Standard Solutions 
1. Obtain and wear goggles. 

 
2. Obtain small volumes, approximately 35 mL of 0.200 M Fe(NO3)3, and 25 mL of 0.0020 
M SCN–, in 2 separate small Erlenmeyer flasks. CAUTION: Fe(NO3)3 solutions in this 
experiment are prepared in 1.0 M HNO3 and should be handled with care. Place fresh DI 
(distilled) water in a wash bottle. Label five beakers: 1–5. Prepare the respective five 
solutions listed in the chart below (The fifth beaker is a blank.), all to 50 mL. This is done by 
using a clean 10.0 mL pipet with bulb to transfer the respective Fe(NO3)3 solution to a 50-
mL volumetric flask and a different clean 10.0 mL pipet to transfer the corresponding SCN- 
solution to the same 50-mL volumetric flask. Now add enough DI water to make exactly 50 
mL of solution. Read the bottom of the meniscus to the fill line. Mix each solution 
thoroughly. Repeat this process for each trial, remembering to clean the volumetric flask 
thoroughly. Measure and record the temperature of one of the above solutions to use as the 
temperature for the equilibrium constant, Keq. 

 

Beaker 
number 

0.200 M Fe(NO3)3 
(mL) 

0.0020 M SCN– 

(mL) 
1 5.0 2.0 
2 5.0 3.0 
3 5.0 4.0 
4 5.0 5.0 

blank 5.0 0.0 
Note: The fifth beaker is prepared to be used as a blank for your Colorimeter calibration. It will 
have a slightly yellow color due to the presence of Fe(NO3)3. By calibrating with this solution as 
your blank, instead of distilled water, you will account for this slight yellow color. 

 
3. Prepare a blank by filling a cuvette 3/4 full of the solution in the fifth beaker. To correctly 

use cuvettes, remember: 
• Wipe the outside of each cuvette with a lint-free tissue. 
• Handle cuvettes only by the top edge of the ribbed sides. 
• Dislodge any bubbles by gently tapping the cuvette on a hard surface. 
• Always position the cuvette so the light passes through the clear sides. 
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4. Connect the Colorimeter to LabQuest and choose New from the File menu on top. 

5. Calibrate the Colorimeter. 
a. Place the blank in the cuvette slot of the Colorimeter and close the lid. 
b. Press the < or > buttons on the Colorimeter to set the wavelength to 470 nm. Press the 

CAL button on the Colorimeter. When the LED stops flashing, the calibration is complete. 

6. Set up the data-collection mode. 
a. On the Meter screen to the top right, tap Mode. Change the mode to Events with Entry. 
b. Enter the Name (Concentration) and Units (mol/L). Select OK.   
c. NOTE: Do not stop until data entry is complete. 

 
7. Collect absorbance-concentration data for the four standard solutions in Beakers 1-4. 

a. Start data collection. 
b. Empty and rinse the cuvette. Using the solution in Beaker 1, rinse the cuvette twice with 

~1 mL amounts and then fill it 3/4 full. Wipe the outside with a tissue and place it in the 
device (Colorimeter or Spectrometer). Close the lid on the Colorimeter. 

c. When the value displayed on the screen has stabilized, Press “collect” icon located on the 
bottom left corner of the screen, then tap Keep and enter the value for the concentration 
(in decimal form) of FeSCN2+ from your Pre-Lab calculations. Select OK. The 
absorbance and concentration values have now been saved for the first solution. DO NOT 
PRESS THE “STOP” BUTTON (red) UNTIL STEP 8. Record your absorbance and 
concentration data in your lab notebook as well. 

d. Discard the cuvette contents as directed by your instructor. Using the solution in Beaker 2, 
rinse the cuvette twice with ~1 mL amounts, and then fill it 3/4 full. Place the cuvette in 
the device, wait for the value displayed on the screen to stabilize, and tap Keep. Enter the 
value for the concentration of FeSCN2+ in Beaker 2, next select OK. 

e. Repeat the procedure for Beakers 3 and 4. Note: Wait until Step 10 to test the unknown. 
Either press “collect” icon to end data gathering or the RED square icon to stop. 

 
8. After stopping data collection, analyze the data immediately to verify precision of data. To 

examine the data pairs on the displayed graph, tap any data point. As you tap each data point, 
the absorbance and concentration values are displayed to the right of the graph. Record the 
absorbance and concentration data values in your notebook. If you want to discard a data 
point, (1) press on “table” icon, select “concentration” and set decimal places to 5, then press 
OK. (2) Search through data in the table, select the questionable data point, press ”table” 
icon, and choose “strike through data”.  (3) “Restore data” will reverse the process. 

9. Display a graph of absorbance vs. concentration with a linear regression curve. 
a. Choose Graph Options from the Graph menu. 
b. Select Autoscale from 0 and select OK. 
c. Choose Curve Fit from the Analyze menu. 
d. Select Linear as the Fit Equation. The linear-regression statistics for these two data 

columns are displayed for the equation in the form 
y = mx + b 

e. Select OK. The graph should indicate a direct relationship between absorbance and 
concentration, a relationship known as Beer’s law. The regression line should closely fit 
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the five data points and pass through (or near) the origin of the graph. Record the linear fit 
equation in your data table. 

 

Part II  Test an Unknown Solution of SCN– 

10. Obtain about 10 mL of the unknown SCN– solution. Use a pipet to measure out 5.0 mL of the 
unknown into a clean and dry 100 mL beaker. Add precisely 5.0 mL of 0.200 M Fe(NO3)3 
and 40.0 mL of distilled water to the beaker. Stir the mixture thoroughly. 

 
11. Using the solution in the beaker, rinse a cuvette twice with ~1 mL amounts and then fill 

it 3/4 full. Place the cuvette of unknown in the device (Colorimeter). 

12. Determine the concentration of the unknown SCN– solution. 
a. Tap the Meter icon located on the top left-hand corner. 
b. Monitor the absorbance value. When this value has stabilized, record it in your data table. 
c. Tap the Graph tab. On the Graph screen, choose Interpolate from the Analyze menu. 

Tap any point on the regression curve (or use the ◄ or ► keys on LabQuest) to determine 
the concentration of your unknown SCN– solution. Record the concentration in your data 
table. 

 

Part III  Prepare and Test Equilibrium Systems 
13. Prepare four test tubes of solutions, according to the chart below. Repeat Steps 11 and 12 

from Part II to test the absorbance values of each mixture. Record the test results in your data 
table. Record the [FeSCN2+] in the table in Data Analysis section #3. Note: You are using 
0.0020 M Fe(NO3)3 in this test. 

 

Test tube 
number 

0.0020 M Fe(NO3)3 
(mL) 

0.0020 M SCN– 

(mL) 
H2O 
(mL) 

blank 3.00 0.00 7.00 
1 3.00 2.00 5.00 
2 3.00 3.00 4.00 
3 3.00 4.00 3.00 
4 3.00 5.00 2.00 
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REPORT SHEET EXPERIMENT 10 NAME:    
PRE-LAB EXERCISE 

For the solutions that you will prepare in Step 2 of Part I, calculate the [FeSCN2+]. Presume that 
all of the SCN– ions react. In Part I of the experiment, mol of SCN– = mol of FeSCN2+. Thus, the 
calculation of [FeSCN2+] is: mol FeSCN2+ ÷ L of total solution. Record these values in the table 
below.  Show your calculations in your lab notebook. 

 

Beaker number [FeSCN2+] 

1  

2  

3  

4  

(blank) 0.00 M 
 

POST-LAB REPORT 

DATA TABLE FOR PARTS I & II 
 

Beaker Absorbance [FeSCN2+] 

1   

2   

3   

4   

Unknown, Part II   
 

DATA TABLE FOR PART III 
 

Test tube number Absorbance 

1  

2  

3  

4  
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DATA ANALYSIS 
1. (Part II) Use the calibration equation from Item 1 and the absorbance reading for your 

unknown solution to determine [SCN–]. 
 
 

2. (Part II) Compare your experimental [SCN–], of your unknown, with the actual [SCN–]. 
Suggest reasons for the disparity. 

 
 
 
 
 
 
 

3. (Part III) Use the absorbance values, along with the best fit line equation of the standard 
solutions in Part I to determine the [FeSCN2+] at equilibrium for each of the mixtures that 
you prepared in Part III. Complete the table and give an example of your calculations 
below. 

 

Test tube number 1 2 3 4 

[FeSCN2+]     

 
 
 
 
 
 
 

4. (Part III) Calculate the equilibrium concentrations for Fe3+ and SCN– for the mixtures in 
Test Tubes 2–5 in Part III. Complete the table and give an example of your calculations. 

 

Test tube number 1 2 3 4 

[Fe3+]     

[SCN–]     

 
 
 
 
 
 
 

5. Calculate the value of Keq  for the reaction. Explain how you used the data to calculate 
Keq. 
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